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1. Introduction

Welcome to OMERO

This document provides a comprehensive guide to the Beta version of the OMERO.importer
and OMERO.insight. These applications together allow you to import your microscopy
images into the OMERO system, and manage, manipulate and view them.

The software was released for general use in June 2007.

This guide includes the following sections:

Section 2 - Getting started with OMERO. Installing the software, and a brief guide to
importing images using OMERO.importer and performing basic image management,
viewing and manipulation tasks using OMERO.insight.

e Section 3 - Advanced OMERO. More details on using OMERO.insight.

e Section 4 - Help and feedback. How you can provide the development team with
feedback to influence future development.

« Section 5 - Background information. The concepts and models behind the OMERO
suite of software.

Enjoy using the software!

The OMERO development team, University of Dundee, UK.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2. Getting started with OMERO

This section provides you with the essential information you need to perform key tasks using
OMERO:

Installing the software;

Logging in;

Importing images;

Viewing single/multiple image(s);
Annotating images;

Saving images.

More advanced tasks are described in .

2.1.Installing OMERO.importer and OMERO.insight
2.2.Logging in

2.3.Importing images

2.4.Viewing images

2.4.1.Viewing a single image

2.4.1.1.Viewing z-sections or timepoints

2.4.1.2.Adjusting channels

2.4.1.3.Additional viewing options

2.4.2.Viewing a selection of images: the Hierarchy Viewer
2.5.Saving images

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.1. Installing OMERO.importer and OMERO.insight

Latest versions of OMERO.importer and OMERO.insight are available for download from:
http://trac.openmicroscopy.org.uk/omero/wiki/MilestoneDownloads

Once you have downloaded the OMERO.importer and OMERO.insight installer packages,
double-click the packages to start the install process.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.2. Logging in

The log-in procedure is the same for OMERO.importer and OMERO.insight.

When you start OMERO.importer, you will be asked to log in (See Figure 2.2-1). The
administrator who set up OMERO can provide you with a user account and the address of
the OMERO.server where your images will be stored.

You provide the address of the OMERO server by selecting the a button and entering the
details in the form provided.

QRN MACTOSCORY evirgnmaent DRET! VIO STV EHHTIET A

OMEROQ.importer OMERO.insight

Flaids Lo In sk m e ey w1 Ty,
Ll —
T— ksl 0 ]

Figure 2.2-1 : Log in screens for OMERO.importer and OMERO.insight

Once logged in successfully, the appropriate OMERO application will open up.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.3. Importing images

OMERO currently allows you to import the following file formats:

* Bio-Rad PIC (*.pic)

» Deltavision (*.dv, *.r3d, *.r3d_d3d)

« Digital Imaging and Communications in Medicine (*.dcm, *.dicom)
* Leica (*.lei, *.tif, *.tiff)

Metamorph STK (*.stk)

» Tagged Image File Format (*.tif, *.tiff)

e  Zeiss Laser-Scanning Microscopy (*.Ism)

You can use OMERO.importer to select images from a storage disk and import them into the
OMERO system.
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Figure 2.3-1 : OMERO.importer in File Viewer mode
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Figure 2.3-2 : import window, showing images destination and filename options

@80 mport
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To import images into OMERO:

1.

2.

Log into OMERO.importer. The application will open a window similar to that shown in

Figure 2.3-1.

Use the File Viewer panel to browse and select one or more images you would like to

import.

Add the selected images to the list of images for importing (referred to as the Import
Queue ) by selecting the plus button: ,:.'I.:]

The import window appears - see Figure 2.3-2 , prompting you to select a Project and
Dataset - this will be the destination on the OMERO.server for the imported images. In

this window you can:

a. Select an existing Project and Dataset from the menus shown, if you have
previously created them in either OMERO.importer or OMERO.insight.

b. Or, for first-time OMERO users, use the Add button to create a new Project. You
can then create a new Dataset in your new Project, or a new Dataset in an existing

Project.

c. The bottom half of the import window (see Figure 2.3-2 ) also allows you to select a

filename from one of three options:

I. the "short" file name e.g. "mylmage.dv",
ii. the full path name e.g "c: important_work/stuff/mylmage.dv",

iii. the short file name plus a number of leading directories, e.g. if you choose to
add one directory to the directory "c:important_work/stuff/mylmage.dv", your

final imported image would be named "stuff/mylmage.dv".

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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d. You can also choose to import a copy of the image file in its original format.

5. You can continue to select more images to add to the Import Queue, by following steps
2-4 above.

6. Once you have finished selecting images, select the Import button at the bottom right
hand corner of the window. The import process will now start. You can view the progress
in the Status column of the Import Queue window. You may also add additional images
to the import queue while an import is already running. This will only add the images to a
new queue - when you are ready to import these new images, click the import button
again to begin importing them.

7. When all selected images have status of "done", your images have been successfully
imported, and you can then move to OMERO.insight to start working with your images.

OMERO.importer has two additional options to File Viewer mode:

*  The Output Text mode: clicking on the Output Text tab shows you a brief list of the
current import status as files are being imported.

* The Debug Text mode: clicking on the Debug Text tab shows you more technical
information about the import status as files are being imported.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.4. Viewing images

Once you have imported some images using OMERO.importer, open OMERO.insight to view
them either individually or as a selection of thumbnails.

When you first log in to OMERO.insight, you will see the image filenames listed under the
relevant Project and Dataset in OMERO.insight's Data Manager (see Figure 2.4-1).

See Section 3.1 for a fuller description of the Data Manager.
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Figure 2.4-1 : Data Manager Window, showing images stored in OMERO

2.4.1.Viewing a single image

2.4.1.1.Viewing z-sections or timepoints

2.4.1.2.Adjusting channels

2.4.1.3.Additional viewing options

2.4.2 . Viewing a selection of images: the Hierarchy Viewer
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2.4.1. Viewing a single image

To view an image:

e  Either double-click on the image filename,
» Or select the image filename, and then select the View Image button E

In either case the image will be displayed in a new window - the Image Viewer window. The
Image Viewer allows you to view your image in three different ways:

e Standard Image View (see Figure 2.4.1-1).

* Annotation View: reduced size image with details of annotations shown (see Figure
2.4.1-2).

»  Split View: showing each channel as a separate image (for multi-channel images), plus
composite image, side-by-side (see Figure 2.4.1-3).

You can view more than one image at the same time -each will open in a separate Image
Viewer window.
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Figure 2.4.1-1 : Image Viewer, Standard  Figure 2.4.1-2 : Image Viewer, Annotation
View View
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Figure 2.4.1-3 : Image Viewer, Split View

2.4.1.1.Viewing z-sections or timepoints
2.4.1.2.Adjusting channels
2.4.1.3.Additional viewing options

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.4.1.1. Viewing z-sections or timepoints

For images with multiple z-sections or timepoints, OMERO allows you to easily view these
manually or automatically.

To manually view composite z-sections or timepoints for an image in the Image Viewer
window (all three views):

* Use the vertical Z slider to manually view individual z-sections.
* Use the horizontal T slider to manually view individual timepoints.

Or, open the Controls menu and select the Movie option to open the Movie Player. Here
you can play all z-sections or timepoints in sequence, as a movie.

Alternatively, Holding down the mouse button and dragging the mouse vertically up or down
the image moves through z-sections; dragging horizontally moves through timepoints.
Dragging diagonally will simultaneously change z-sections and timepoints.

For more details on viewing z-sections and timepoints using the Movie Player, see Section
3.9.4.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.4.1.2. Adjusting channels

To adjust channels for multi-channel images, in the Image Viewer (Standard View or Split
View):

* Use the colour buttons on the left-hand side of the image to turn on or off a colour
channel.

»  Switch between colour and greyscale representations of the image by going into the
Controls menu, selecting Models , and choosing Colour or Greyscale .

For more details on adjusting channels, see Section 3.9

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.4.1.3. Additional viewing options

The Image Viewer provides a number of additional tools:

* Adjust the image properties using the Rendering Tool (see Section 3.9.3.5).

* Magnify an image or area of interest within the image (see Section 3.9.3).

* View in greyscale; or view additional information about the image (see Section 3.9.2).
»  Configure the optional scale bar (see Section 3.9.3.3).

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.4.2. Viewing a selection of images: the Hierarchy Viewer

A selection of images for viewing can be made at different levels, based on how your data is
organised in OMERO. You can:

*  Select one or more projects - this selects all images in each dataset belonging to the
selected project(s) groups.

»  Select one or more datasets - this selects all images in the selected datasets.

*  Select one or more images, by using the keyboard and/or mouse to select more than
one image filename from the list shown in the left-hand pane.

You can also select images according to the Category they belong to, which is another way of organising your
data - you define your own category groups and categories, and then you can place your images into one or more
categories. For more on categories, see Section 3.7.

To view a selection of images:

1. Inthe Data Manager, select the first project, dataset, category group, category or image
you wish to view by clicking once to highlight it.

2. Use the appropriate keys for your operating system to select subsequent projects,
datasets, category groups, categories or images.

You can only select multiple objects of the same level - for example you can select 5 images, but not one dataset
plus 5 images. However, you can select individual datasets from different projects if desired.

3. Once you have your selection, select the Browse button ! This brings up a Hierarchy

Viewer window showing a series of thumbnails, one for each image in your selection
(see Figure 2.4.2-1).

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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Figure 2.4.2-1 : Hierarchy Viewer, showing simple selection of images

The Hierarchy Viewer also provides:

e arange of tools for viewing individual thumbnails;
e options to rearrange the display of thumbnails;

» facilities to display and edit information relating to a particular thumbnail.

See Section 3.10.2 for more details.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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2.5. Saving images

You can save a copy of any image displayed in the Image Viewer, in a number of different
image formats. This may be particularly useful for having a copy to include in a presentation
or publication.

1. Open the Controls menu and select the Save As option. Or, select the | icon in the

Image Viewer .
2. Inthe Save Image window you can:

a. Specify the name of the saved image file.

b. Select the destination of the saved image file (this can be set to be the default folder
for future save operations).

c. Select the saved image file format from a choice of BMP, JPEG, TIFF or PNG.

d. Choose the type of image to save - in the Images menu, select from:

A simple image;

* Image and split channels in grid form;

* Image and split channels in a row;

* Image and split channels in a row, in grey;
 Lensimage;

* Lensimage and split channels;

* Lensimage and split channels in grey.

3. You will see a preview of the image to be saved before you confirm the save action.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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3. Advanced OMERO

This section provides more in-depth information on the tasks OMERO.insight supports.

3.1.Getting to know the Data Manager
3.2.Viewing and editing user account details
3.3.Managing projects and datasets
3.3.1.Creating projects and datasets
3.3.2.Renaming projects or datasets
3.3.3.Removing projects or datasets
3.3.4.Expanding a project to see constituent datasets
3.3.5.Expanding a dataset to see constituent images
3.3.6.The Projects, Categories and Images tabs
3.4.Viewing other people's images
3.5.Additional information about projects, datasets and images
3.6.Annotations

3.6.1.Viewing annotations

3.6.2.Annotating a single image or dataset
3.6.3.Annotating multiple images or datasets
3.7.Categorising images

3.7.1.Creating category groups

3.7.2.Creating categories

3.7.3.Removing categories and category groups
3.7.4.Categorising images

3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
3.8.Sorting and finding images

3.8.1.Sorting images

3.8.2.Retrieving selected images

3.8.3.Finding images with Find in Tree
3.9.Viewing images

3.9.1.Viewing a specific Channel
3.9.2.Additional viewing options

3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration

3.9.2.4.Image information

3.9.2.5.Annotation View

3.9.3.Magnification

3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar

Copyright © 2006-2007 University of Dundee. All Rights reserved.
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3.9.4.Viewing z-sections and timepoints
3.9.4.1.Automated viewing of z-sections and timepoints
3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
3.9.5.Image Rendering options

3.10.The Hierarchy Viewer: viewing multiple images
3.10.1.Viewing an image from the Hierarchy Viewer
3.10.2.Using the Hierarchy Viewer

3.10.2.1.Adjusting thumbnail display

3.10.2.2.Display Tree View of images

3.10.2.3.Sorting images

3.10.2.4.Managing images in the Hierarchy Viewer
3.10.2.5.Additional image information: the Working Area
3.11.Managing windows in OMERO.insight
3.12.Closing OMERO.insight
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3.1. Getting to know the Data Manager

Every time you log in OMERO.insight, you will see Data Manager's default screen, which
consists of several areas of interest as labelled in Figure 3.1-1 .

1. The left-hand pane shows projects and datasets, category groups, categories or images
in a hierarchical manner. (Note that on first accessing OMERO.insight, this pane will be
empty until you create a project.)

2. The right-hand pane shows information relating to the currently selected project, dataset,
category group, category or image; and will be blank if none exists or none is selected.

3. Above the two panes are three distinct navigational areas. From the top of the page,
these are:

a. Application-wide toolbar. This gives access to options that remain constant
throughout use of the Data Manager.

b. The Projects , Categories and Images tabs. These specify what information is
shown in the left-hand pane.

c. Context-specific toolbar. This provides options specific to whether Projects and
Datasets, Category Groups and Categories, or Images are being shown in the
left-hand pane.

4. Finally, there are five application menus, each offering options based on the current
status of OMERO.insight. The menus available are File , Edit , View , Window and
Help .
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| (sHala) Jean-Marie Burel's Data Manager
File Edit View Window Help
v Bawe

—{ %, Projects | = Categories | P 3p

4

A

. O] =
¥ &% Jean-Marie Burel Br
» j Orphaned Datasets [14]
¥ |5 Elite Project [1]
> B test create (2]
> @ project one [2]
> & test [2] - >

b

Figure 3.1-1 : Data Manager, default screen with three projects listed

If you wish to send a comment to the OMERO development team, open the Help menu and select Send
Comment .
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3.2. Viewing and editing user account details

You can make a limited amount of changes to your OMERO account details in the Data
Manager.

At the top of the tree in the left-hand pane of the Data Manager is your own user name. Click
on this to see your user account details, shown in the right-hand pane (see Figure 3.2-1).
There are two tabs:

* My Profile shows basic personal information.
My Servers shows all OMERO servers for which you have a user account.
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Figure 3.2-1 : User Profile Editor

The only edits you can make at present is to change your OMERO password using the form here. Future releases
of OMERO will allow you to make additional changes to your account, which currently can only be made by users
with OMERO administrator status. The ability to change from one server to another will also be added in future
versions.
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3.3. Managing projects and datasets

In Section 2.3 we explained how to create projects and datasets as part of the Import
process; OMERO.insight also allows you to create and manage projects and datasets.

The following icons are used in OMERO.insight:

. j denotes a project.
. @ denotes a dataset.
. :} denotes an image.

3.3.1.Creating projects and datasets

3.3.2.Renaming projects or datasets

3.3.3.Removing projects or datasets
3.3.4.Expanding a project to see constituent datasets
3.3.5.Expanding a dataset to see constituent images
3.3.6.The Projects, Categories and Images tabs
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3.3.1. Creating projects and datasets

To create a project in OMERO.insight:

1. Inthe File menu, select Create New project . Or, select the B icon.

2. In the window that appears (see Figure 3.3.1-1), enter the name of the new project. You
can optionally add a textual description of the project.

3. Select Save to confirm.

4. Your project should now be created (Figure 3.3.1-2 shows a new project created and

named DenoPr o ect).
Project | |
Add a new project ;

Descrip tion

Figure 3.3.1-1 : Insight's 'Add a new project’ window
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Figure 3.3.1-2 : Data Manager showing details of a selected project

To create a dataset in OMERO.insight:

1. Select the project in which you want to create the dataset. The right-hand pane now
shows information about the selected project (see Figure 3.3.1-3).
2. From the File menu, select Add New Dataset . Or, select the | | icon.

3. Inthe window that appears, enter the name of the new dataset, and a textual description
if you wish.

4. Select Save to confirm the addition.

5. The dataset should now be listed in the left-hand pane, under the relevant project (see
Figure 3.3.1-4).
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a6 Jean-Marie Burel's Data Manager
File Edit View Window Help

gl awe

—{ 4 Projects - Categories L-L_'HT"_}—

B ola -
¥ & Jean-Marie Burel

> @ Orphaned Datasets - 'y Create new element

> S| Elite Project [1]
» (S| ffff (1] D;tﬁ:tnm dataset to project: project one
¥ i project one (2] - -
» [5i dataset one [1]
» [5il daraset three (]

> & test (2] Naine |

Description

Save

Figure 3.3.1-3 : Adding a new dataset to an existing project

( Close ]I ,
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000 Jean-Marie Burel's Data Manager

File Edit View Window Help

g LE DT

= EE Projects | % Categories L — Dataset
Edit the dataset: test create o

. | | = S

¥ &3 Jean-Marie Burel

| j Orphaned Datasets [13]

¥ [ Elite Project [1] ! G Properties = [ Annotation j
b G test create [2]

- IE fFF [1] [] 111

| E project one (2] - Name hest create

> (5 test (2] Description

Owner |ean-Marie Burel

E-mail j.burel@dundee.ac.uk
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Figure 3.3.1-4 : Data Manager showing one available project, containing one dataset
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3.3.2. Renaming projects or datasets

To rename a project or dataset:

1. Select the project or dataset.

2. Inthe right-hand pane, edit the text in the Name field.

3. Select Save to confirm changes.
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3.3.3. Removing projects or datasets

To remove a project or dataset:

1. Inthe left-hand pane of the Data Manager, select the project or dataset to be removed.

2. Inthe Edit menu, select Remove (or Remove from current project for a dataset). This
removes the selected project or dataset. '‘Orphaned Datasets' will be created to hold the
removed dataset(s).

3. The removed projects or datasets will go to '‘Orphaned Datasets', which appears on top
of the tree view. The number in the bracket shows how many removed datasets are in.

When you remove a project, the dataset(s) in it will be listed in the ‘Orphaned Datasets' and therefore you will not
see the name of the project but only the dataset(s). A project or dataset is only removed from a project - it is not
deleted from the system.
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3.3.4. Expanding a project to see constituent datasets

In the left-hand pane you might see projects listed but not their datasets (Figure 3.3.4-1). The
number in square brackets after the project name is the number of datasets belonging to the
project.

To see all datasets belonging to a project, click the Expand icon: p .

All datasets associated with the selected project will now be shown (Figure 3.3.4-2). This icon
will change appearance to ¥ to show that the project has been expanded to show datasets -

clicking the icon again will collapse the display to show just the project again. Note that in
Figure 3.3.4-1, the Anot her DenoPr oj ect image has no datasets - so cannot be expanded.

t& Projects - Categories L tE Projects - Categories L
Djdh| ~ | . | B -
| AnotherDemoProject 0] - _:| AnatherDemoProject [0]
» 5| DemoProject [2) ¥ =| DemoProject [2]

» |5l TestDataset1 [10]
* i TestmDataser? [5]

Figure 3.3.4-1 : Project listing without Figure 3.3.4-2 : Project expanded to show
datasets datasets
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3.3.5. Expanding a dataset to see constituent images

The number in brackets after a dataset name is the number of images belonging to that
dataset.

To see all images belonging to a dataset, click the Expand icon as above - the images will
now be listed (Figure 3.3.5-1).

' ‘Eﬁmeds b Categories |
_Mclal- |-
* 5| AnotherDemoProject [0]
¥ || DemoProject [2)
» il TestDataserl [10]
¥ & TestDataset2 [5)
3| .TestImages/23srpSdksub.stk
3| . Test Images/654Atemp. stk
4| .. Test Images/Img_R30.dv
3| .. .Testimages/PA-SD5-RFP-CenE
3| . Testimages/T2987_G1_BFOI_

Figure 3.3.5-1 : Expanded dataset showing images

The file path name shown, in particular the number of directories preceding the filename, reflects the settings
specified when importing using OMERO.importer. See Section 2.3 for choosing display options for lists of image
filenames.
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3.3.6. The Projects, Categories and Images tabs

You will see that in Figure 3.3.5-1, above the left-hand pane there are two tabs - Projects
and Categories visible, plus an arrow tab rT~| .

| S

There should in fact be three tabs - the hidden one is the Images tab. If you only see two
tabs, clicking on this tab gives you a menu showing all three options, allowing you to select
the Images tab. Alternatively, hold down the mouse pointer in the space between the left and
right-hand panes, and drag to the right to widen the left-hand pane until all three tabs appear
(as in Figure 3.3.6-1).

The arrow tab is reversed when only the Categories and Images tabs are shown: ) In this case, click

SR
the tab to access the Projects tab.

The Images tab is discussed further in Section 3.7, and the Categories tab is discussed further in Section 3.8.

-'_'1, Projects = Categories o Images

B -
¥ <2 David Sloan i
* J Orphaned Datasets [4]
¥ [\ China [1)
¥ |5 Tsingtao [2)
2] ... Test Images /654 Atemp. stk
] ... Test Images/img_R3D.dv
¥ | & South America [1]
¥ 5 Brazil [18)
] ...tubhiswt-40/tubhiswt_C2_TP1...
@J - ubhigwt-4D ubhiswt_C2_TP1...
&) ...ubhiswi-4 D ftubhiswt_C2_TF1...
fﬂ ubhiswt-40 ubhiswt C2_TPL...
] ...tubhiswi-40/tubhiswt_C2_TP1...

Figure 2.3.6-1 : Expanded left-hand pane showing three tabs
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3.4. Viewing other people's images

OMERO supports collaborative work by allowing users to share images among group users.
Assuming the appropriate permissions have been granted by the image owner, it will be
possible for

* You to select another user and view their images;
»  Other people with an OMERO account to view your images for which you have enabled
permission for others to view.

To select another user, view, and - if desired - annotate their images:

*  Click on the Switch user icon &3 Or, open the File menu and select Switch user ;

 Choose the OMERO group in which the user belongs;
» Select the user from the menu that appears (see Figure 3.4-1), and select Apply .

The user's data will appear in a new Data Manager window.

Switch Wser

Switch user .
Celect a user and wiew his Sher data. o |

Groups 'F-'ntdle:r:n- Lab OMERD

14k

Users ol Jean-Marie Burel
234 Brian Loranger
e Catriona MacCauliy
24 Donald MacDonald

it Jason pwedlow

Camcel |

Figure 2.4-1 : Switch User selection menu

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-32


figure_19

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-33



OMERO clients User Guide

3.5. Additional information about projects, datasets and images

You can view additional information to a selected project, dataset or image. This is available
in the right hand pane of the Data Manager:

« The Properties tab shows you the name and description of the selected project, dataset
or image. In future versions of OMERO.insight, you will be able to set permission levels
for accessing the selected project, dataset or image (see Figure 3.5-1).

« The Annotations tab allows you to see and add annotations to the selected dataset or
image. You cannot add an annotation to a project. For more on Annotations, see Section
3.6.

 The Info tab is available when an image is selected. This provides information about the
image, including X, Y dimensions, number of z-sections and timepoints, pixel sizes and
number of emission wavelengths.

1, P g 3 [ 2
3 Lt 1hm irage Eubbaart - A0 Twbbipard € 1_ TR S0
N =
¥ L Dl Naian
e 1 Fats 1

T3 Pty [ dreodamor. #| v
Tau wugauremg &30y T

e

P L LT

L =mad

m L s s BN T

FEERNNERERNY
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Figure 3.5-1 : Viewing permissions information for a selected image
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3.6. Annotations

OMERO lets you add annotations - textual notes - to any image or dataset in your collection.
You can also add annotations to any other images that you have permission to see.

3.6.1.Viewing annotations
3.6.2.Annotating a single image or dataset
3.6.3.Annotating multiple images or datasets
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3.6.1. Viewing annotations

The @I icon shows that a dataset has one or more annotation (see Test Dat aset 1 in Figure
3.3.4-1 for an example).
The E‘_'?_i icon shows that an image has one or more annotations.

To view annotations in the Data Manager:

1. Select the image or dataset for which you wish to see the annotations.
2. Select the Annotation tab in the right-hand pane.
3. A window appears with two panes (see Figure 3.6.2-1):

* The left-hand pane shows a tree-list of all annotations for the selected image,
dataset or project, plus date and time the annotation was made. Annotations are
grouped by users, allowing you to see any annotations made by other users.

*  The right-hand pane provides an area for you to add a new annotation; it also shows
the content of all existing annotations.

You can also view an image's annotation(s) in the Image Viewer - see Section 2.4.1, or in the
Hierarchy Viewer - see Section 3.10.
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3.6.2. Annotating a single image or dataset

To add a new annotation to a selected image or dataset:

1. Making sure the Annotation tab is selected, type in a new annotation in the right-hand
pane.
2.  On completing the annotation, select the Save button to confirm.

On saving, the annotation will be 'stamped' with the user who created the annotation, and the
time the annotation was created.
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Figure 2.6.2-1 : Adding an annotation to an image

You can also add an annotation to an image in the Image Viewer - see Section 3.9.2.5, and
in the Hierarchy Viewer - see Section 3.10.2.5.
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3.6.3. Annotating multiple images or datasets

OMERO allows you to add an annotation to a selection of images or datasets, all at once.

To do this,

1.
2.
3.

ab

Select the images or datasets.
Select the toolbar icon @

This opens up the Annotate dialog box (see Figure 3.6.3-1). It shows you, in three
panes:

a. the list of images or datasets selected,

b. atree view showing names of users who have added annotations; expanding a user
name shows the time of each annotation added.

C. space to add a new annotation or see the text of any existing annotation.

Enter the annotation text in the right hand pane.

Select Save ; a message box appears (see Figure 3.6.3-2). Choose the All option to
save the annotation for all selected images or datasets; or One to save the annotation
for only the first selected item - the one named in the message box.

B,

' 12
Arrclsin
Aanciste tha nplected Fema ; ‘,_,-l'?:

L annctstion Bor bubfivwt- &0 tubhdewt L2 TRILEE

5| oninhiper- 4D ibosen C2_TPROE b o wewd g (L LR LL e
=) . aEhbert-d0 ebfewd O3 TPLEE 7 O Dusid Sais (0]
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Figure 3.6.3-1 : Annotating multiple items
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Baa Lave annatation

tubhiswt-40tubhiswt_C2_TP20.tiff or to
all items in the annotation list?

@ Do you want to apply this annotation only o

( an Y({ oOne ) Canedd )

Figure 3.6.3-2 : Multiple annotation confirmation

Copyright © 2006-2007 University of Dundee. All Rights reserved.

Page-39



OMERO clients User Guide

3.7. Categorising images

OMERO.insight allows you to create categories for use in managing your images, as a
separate means of organisation from the Project/Dataset structure. To do this, first you create
a category group, and then create one or more categories within the category group. Once
you have some Categories, you can then use these to categorise your images.

Icons used:

Y denotes a category group.

* (9 denotes a category.

. _.fii denotes a categorised image.

. Eﬁ denotes a categorised image that also has one or more annotations.

3.7.1.Creating category groups

3.7.2.Creating categories

3.7.3.Removing categories and category groups
3.7.4.Categorising images

3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
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3.7.1. Creating category groups

Creating a category group is a similar process to creating a Project:

1.

2.

ab

Select the Categories tab. This will bring up a list of existing Category Groups (or will be
empty if none exist).

Then:

»  Either click the Create Category Group toolbar button B

* Orgo to the File menu, and select the New Category Group... option.

In the right-hand pane, enter the Category Group name, and an optional textual
description (Figure 3.7.1-1).

Select Save to confirm.
Your Category Group should now be listed in the left-hand pane.

Category group I '|
Add a new categaory groug

Name
Dt ription .-

Save Clade

Figure 3.7.1-1 : Adding a Category Group

Copyright © 2006-2007 University of Dundee. All Rights reserved.

Page-41



OMERO clients User Guide

3.7.2. Creating categories

Creating a category is a similar process to creating a dataset:

1. Select the category group into which the category should go (i.e. make sure it is
highlighted in the left-hand pane).
2. Then:

Either click the Create Category toolbar button |
* Orgo to the File menu, and select the New Category... option.

3. Inthe right-hand pane, enter the Category name, and an optional textual description.

4. Select Save to confirm.

5. Your Category should now be listed in the left-hand pane, under the appropriate
Category Group.

Figure 3.7.2-1 shows a list of category groups with categories. The number in brackets after
each category group name indicates how many categories belong to that group; similarly the
number after each category name indicates how many images belong to that category.

[ ] e
"[=‘-'"n]r-.'t'. 5= Categories E: Images

¥ 23 David Sloan

¥ [l Orphaned Categories [1]
¥ & 13th Decernber [2]

2 Haugesund [0]

» (3 Stavanger [3]

¥ & 2Znd May [2]

(3 Mo-i-Rana [0)

& Narvik [0]

Figure 3.7.2-1 : List of category groups with categories
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3.7.3. Removing categories and category groups

To remove a category from a category Group:

1. Select the category to be removed.

2. Inthe Edit menu, select Remove .

3. The category will be removed from the category group. '‘Orphaned Categories' will be
created to hold the removed category.

4. The removed category will go to 'Orphaned Categories’, which appears on top of the tree
view. The number in the bracket shows how many removed categories are in.

5. Similarly, to remove a category group, select the category group to be removed, and use
the Edit menu as above.

A category or category group is only removed from a project - it is not deleted from the system.
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3.7.4. Categorising images

Once you have created one or more categories, you can categorise your images.

3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
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3.7.4.1. Categorising a single image

To categorise an individual image:

1. Select the image filename.
2. Then:
* Either in the Edit menu, select Categorise .
 Orselect theL 7 toolbar button and then Categorise from the pop-up menu that
appears.

3. Inthe right-hand pane, you will initially see a list of available category groups. Select the
appropriate category group and expand it by selecting the Expand button p .

4. Tick all categories you wish to add the selected image to. ( Select All and Deselect All
buttons are available to speed up the task of selection).
5. Select Save to confirm the categorisation.
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3.7.4.2. Categorising multiple images

If you wish to add more than one image to the same category or categories, the steps
described in Section 3.7.4.1 can be applied for multiple selected images.
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3.7.4.3. Viewing images in a category

To view all images in a selected category:
Select the Categories tab.

1.
2. Inthe left-hand pane, expand the category group and select your chosen category.
3. The list will expand to show all images currently in that category (see Figure 3.7.4.3-1).

. LT:: Projects &: Categories E‘-_ Images |

. 'T"'lﬁ - .

¥ = David Sloan
¥ ] Orphaned Categories [1]
¥ & 13th December [1]
¥ (® Savanger [3)
= ...Test Images/2 3srpSdksub.stk
|25 ... Test Images/654Atemp, stk

B ... Test Images,/T2987_C1_BFOL_R3...

Figure 3.7.4.3-1 : Viewing all images in a selected category
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3.7.4.4. Removing an image from a category

To de-categorise an individual image:

1. Select the image filename.
2. Then:
» Either in the Edit menu, select Decategorise .
 Orselect theL 3 toolbar button and then Decategorise from the pop-up menu that
appears.

3. Inthe right-hand pane, you will initially see a list of available Category Groups. Select
the appropriate category group and expand it by selecting the Expand button: p .

4. Tick all categories from which you wish to remove the selected image. ( Select All and
Deselect All buttons are available to speed up the task of selection).
5. Select Save to confirm the de-categorisation.
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3.8. Sorting and finding images

As you build up collections of images, you may wish to sort them into manageable groups, or
find a specific image or group of images in your collection. OMERO.insight allows you to sort
images by various techniques, and also to search for a specific image(s).

3.8.1.Sorting images
3.8.2.Retrieving selected images
3.8.3.Finding images with Find in Tree
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3.8.1. Sorting images

A number of options are available for sorting a collection of images. These are provided in

the context-specific toolbar (labelled as 3c in Figure 3.1-1) directly below the Projects ,

Categories and Images tabs (Figure 3.8.1-1), and are available to a list of images.

Wola -

Figure 3.8.1-1 : Toolbar providing sort options

These options are:

laz - Alphabetical sort. Select this option to sort image file names in alphabetical order. In the
illustration in Figure 3.8.1-1, this option is selected, and hence the icon appears shaded.

@ - Date sort. Select this option to sort image file names in order of the date they were

taken on the microscope - and if this information is not available, in order of the date of import

into OMERO.

If the list of images shows more than one open dataset or category, images are sorted alphabetically or by date
only within their parent dataset or category - although the order in which datasets or categories appear may
change.

d% - This option allows you to toggle between showing a truncated path name and full path
name for each listed image. Figure 3.8.1-2 and Figure 3.8.1-3 show the difference in image

display names.

¥ (il Croup 3 [3] ¥ i Group 2 [2]
¥ 3 DemoCategony? (1] ¥ (3 Demolsegoryt? 11
_ 5 Test images 2 3epidkeub. stk S8 Uk e DR A0 oo (T S L It 2 14 p Sd i 1k
Figure 3.8.1-2 : Truncated image Figure 3.8.1-3 : Full image pathname

pathname

The actual number of directories shown in the full image pathname depends on the option chosen when importing
the image using OMERO.importer.
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¥ - This option expands to reveal a menu with further options for viewing images, discussed
in more detail in Section 3.8.2. Itis only visible when the Images tab is selected;

— - This option allows you to quickly collapse the current list of image filenames to show
only parent projects or category groups.

If at any time the left-hand display appears not to be showing the information you expect, select % or Refresh

Current Tree from the File menu to refresh the display.
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3.8.2. Retrieving selected images

You can retrieve selected images from your collection of imported data by filtering out images
based on the categories they belong to or by datasets.

Filtes Iridges Retrieyval

Filter images retrieval | |
Lalect items in the following lise J
Limi¢ the images retrieval by sedecting items in the fallowing
lige of daraseds

!l e
& bempd

il TestDamser]
= g TedtDutaser?

5¢-|¢|:1.|l|]! _I:_:Eulm:l: All bty _Earu'r:!
Figure 3.8.2-1 : Filter images retrieval window

Clicking the Images tab (see Section 3.3.2) results in a new window being displayed - the
Filter Images Retrieval window (Figure 3.8.2-1). This allows you to specify which image
filenames you would like to see listed in the left-hand pane. You have three choices:

1. Select images from chosen datasets.
2. Select images from chosen categories.
3. Select all images in your collections.

Select the Image menu button ¥ to see the Image menu (shown in Figure 3.8.2-2). This
allows you to specify how Filter Images Retrieval will work.

On choosing either of the first two options in the list above, the Filter Images Retrieval
allows you to select those datasets or categories from which you wish to retrieve images. All
image filenames found will then appear in the left-hand pane.
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Figure 3.8.2-2 : Menu for configuring Filter Images Retrieval
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3.8.3. Finding images with Find in Tree

The Find in Tree feature works in a similar way to the 'Find in Page' feature provided by
many Web browsers. It allows you to search for a text string within all items displayed in the
left-hand pane (Figure 3.8.3-1).

[CLhN ] [LFES TR | T
L] ke r-
[, W abegidri i | § Weiage E.'}' _:.--l
S [ ol Uiy il ! D i ¢ T b o A v o T ——
s -
T o Enil i =
w ) Cophi s
v ¢ Fgpriigy |7 Areniae pe ]
nan
L i K%
i Bar=g
. L [ PP Y
areL s O
- R e O
a0 e L
AT et €2
TR A | DT
dyrad LT b 0 Dl
by L a7
By A e
F lag Rarsriale ]
v Bl boreay 2
i Fil Frags e R Grem
B TR P Wl i
v i e
& il et
. i
3 [T
I.‘-"\cd'
- T [ SRR Er
B TEn g iy N oy Crvemiond
[ —"_ ] T

lind: BE4A g e Pl Pyl | W ane b g i L e wen foardd

Figure 3.8.3-1 : Find in Tree request showing results

To conduct a search:

1. Inthe Edit menu, select Find in Tree . A form will appear at the bottom of the Data
Manager window.

2. Type the text string you wish to search for in the Find : text box.

3. Use the arrow icon « to select whether you wish to find a pattern in image names or

descriptions.
4. The Match Case checkbox can be checked if you want to ensure that image filenames
are returned only if they match the case of the text string you specify.

The search will be dynamically conducted, reporting how many images were found that
match your search criteria. The first image found will be highlighted (Figure 3.8.3-1); use the
Find Next or Find Previous buttons to move through each image found. If no images are
found, a Phrase Not Found message is shown.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-54



OMERO clients User Guide

The Find in Tree feature can also work with datasets, projects, categories and category groups - i.e. whatever is
currently listed in the left-hand pane.
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3.9. Viewing images

In Section 2.4.1 we described how you can view an image in constituent channels, time
points or z-sections in OMERQO's Image Viewer.

Section 2.4.2 described how thumbnails of a selection of images can be viewed using the
Hierarchy Viewer.

This section provides further information on viewing images using the Image Viewer.

ERa o
T e ko

T

@ 2=251 T=0y'%

Figure 3.9-1: The Image Viewer, standard view

3.9.1.Viewing a specific Channel
3.9.2.Additional viewing options
3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration
3.9.2.4.Image information
3.9.2.5.Annotation View
3.9.3.Magnification

3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar

3.9.4.Viewing z-sections and timepoints
3.9.4.1.Automated viewing of z-sections and timepoints

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-56



OMERO clients User Guide

3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
3.9.5.Image Rendering options
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3.9.1. Viewing a specific Channel

The channel buttons (shown as the four coloured squares labelled 457, 528, 617, 685 in
Figure 3.9-1) enable you to turn on or off specific channels for multi-channel images.
Turning on or off a channel will result in an immediate visual change to the image shown in
the Image Viewer.

The colour band selected for a given channel corresponds to the emission wavelength of the
channel. If this information is not available, the channels will be mapped to red, green and
blue. The colour used to display any channel can be customised using the Colour Picker
(Section 3.9.2).

Channels can be turned on or off by clicking the relevant channel selection button, aligned
vertically on the left edge of the Image Viewer window. Buttons show the colour associated
with the channel, plus wavelength in nanometres (if this information is available).
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3.9.2. Additional viewing options

3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration
3.9.2.4.Image information
3.9.2.5.Annotation View
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3.9.2.1. Colour and greyscale viewing

The top two Image Viewer toolbar buttons change appearance depending on the current
state of the image:

D (alternative state is Ij) enable toggling between colour model and greyscale display:

*  To switch from colour display to greyscale, select |j
*  To switch from greyscale to colour display, select ﬂ

The above options can also be chosen by opening the Controls menu and selecting the Models option. This
allows you to choose between Colour and Greyscale options.
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3.9.2.2. Movie viewing across channels
[;9 (alternative state is H H) enable viewing single-channel views of the image, as a movie:

1. To start the movie, select [Eg. . This will display the image for a short period using each of

the currently selected channels in turn.
2.  The movie runs on a loop, and will continue until you stop it. To stop the movie, select
H d The image then reverts to its appearance before the movie started.

This option is available for the Image Viewer's Standard View and Annotation View modes.
Movie options for viewing z-sections and timepoints are described in Section 3.9.4.
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3.9.2.3. Channel configuration

j The Colour Picker button allows you to configure the channel corresponding to a
specific channel button. To associate a specific channel with a channel button:

Click on the Colour Picker button.

In the menu that appears, choose which channel to adjust.

The Colour Picker window opens (Figure 3.9.2.3-1).

You can then select a colour in one of three ways, each available by selecting one of the
toolbar buttons at the top of the window. These options are:

PwnpE

a. Using the HSV colour wheel;
b. Using RGB colour sliders (shown in Figure 3.9.2.3-1);
c. Showing the colour list.

5. Once happy with your settings, select Accept to confirm the changes, or Revert to
ignore the setting changes you have just made.
6. You should now see the channel change applied to the relevant channel button.

P, o N

Y 7Y Colour Picker Window Channel Info

Ef-_ Channel Info
e Gsskascn. (@)

Red Jem—
——— Emission Wavelength (in p) 457
E i}
—! Excitation Wavelength (in p) 457
Creen
e MD Filter 1.0
[ =
= Pin hole size 0
ue

{A'-‘m} ',:_F.!mr‘l: ’, [ Cancel )

Figure 3.9.2.3-1 Colour Picker Figure 3.9.2.3-2: Channel Info window

The Colour Picker can also be accessed by double-clicking on a channel button.

Right-clicking on a channel button gives access to a menu from which you can choose to
bring up the Colour Picker or to display additional information about the channel (Figure
3.9.2.3-2).

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-62



OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-63



OMERO clients User Guide

3.9.2.4. Image information

To view basic information about an image displayed in the Image Viewer, select the Image
Info button 5 B The Image details window then appears (see Figure 3.9.2.4-1).

) Image's details

Image's details
Information about the pixels ... @

Size X 512

Size ¥ 512

Pixel size X (in p) 0.314153
Fixel size ¥ (in p) 0.314153

Pixel size Z (in p) 1.0

Close

Figure 2.9.2.4-1 : Image information window
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3.9.2.5. Annotation View

One advantage of the Annotation View mode of the Image Viewer is that it allows you to add
annotations to an image while looking at it in some detail (see Figure 3.9.2.5-1).

In this view, the Annotations panel is shown in a similar way to the Data Manager, showing
any existing annotations plus the name of the user who added the annotation and the date
they were added; like in Data Manager you can add annotations to the image as desired.

Note that the annotations exist as separate text attributes of the image - the image file itself is
not annotated.
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o SORT-D- LY 22°55:08
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Figure 3.9.2.5-1 : Image Viewer Annotation View
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3.9.3. Magnification

It is possible to view areas of the image in more (or less) detail by setting the magnification of
the image or by using the lens feature. This feature works for all three Image Viewer modes:
Standard View, Annotation View and Split View.

3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar
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3.9.3.1. Magnifying the whole image

To magnify the whole image, use the Zoom feature:

1. Openthe Zoom menu.

2. Choose from one of the predefined magnification levels.

3. The display of the Image Viewer will change to show the selected image (Figure
3.9.3.1-1).

This works in a similar fashion in Standard View, Annotation View and Split View modes.

For increased magnification, you may need to use the Image Viewer's scroll bars to view all
parts of the image; to avoid this, you can resize the Image Viewer window to show an
increased area of the image.

Users fdave / Deskiop/ome] Test Imagesimg_ R30.0w

[
|-||-I'\1|I\.|_.'| 1
— &

-
¥

EEEER-C

¥

M Z=273 T=0/0

Figure 3.9.3.1-1 : Image Viewer showing magnified image
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3.9.3.2. Magnifying an area of the image

The Lens feature allows you to see an area of the image at a greater magnification level than
the Zoom feature. It also allows you to see the magnified section alongside the image as a
whole. It works in a similar fashion in Standard View, Annotation View, and Split view.

1. Open the Zoom window:

«  Either select the Lens toolbar button: (|
* Oropen the Controls menu and select the Lens option.

2. The Zoom window will now appear beside the Image Viewer window, and shows a
magnified area of the image.

Below the image is additional information on the dimensions of the magnified image. The
area of the magnified image is outlined in the main Image Viewer window (Figure
2.9 3 2-1).

To redefine the area of the image being magnified:

1. Click the mouse pointer on the highlighted area in the main Image Viewer.
2. Drag the highlighted area to the area of the image you wish to see magnified.
3. The Zoom window will be updated to reflect the change in area.

To change the size of the magnified area:

1. Inthe Zoom window, select the Lens menu.
2. Choose from one of the predefined window sizes.

NB

You may need to scroll or resize the Zoom Window to see all of the magnified area.

To change the magnification level:

1. Inthe Zoom window, select the Zoom menu.
2. Choose from the predefined list of magnification options.
3. The dimensions shown will be updated to reflect your choice.

To change the units of the dimensions shown in the Zoom Window, select the Units
menu and choose between microns and pixels . You can also zoom using the mouse
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wheel, if your operating system supports this.

Users) dave iDeskiop fome |/ Test Images fimg _RI0.d © [ Foom Window

EEala '_ Lens Zoom Units Lens Color

231¥:231 W:HH:50 =20

Wb I=33 T=070

Figure 3.9.3.2-1 Image Viewer and Zoom window
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3.9.3.3. Scale bar

The Image Viewer by default includes a scale bar in the bottom right corner of the image. In
Figure 3.9.3.1-1, the scale bar shows a length of 5 nanometres - the default setting. You can
configure how the scale bar is displayed, using the View menu.

To remove the scale bar from the current image display:

1. Select the View menu.
2. Select the Show Scale bar option.

To show the scale bar, repeat the steps above.
To change the length of the scale bar:

1. Select the View menu.
2. Select Scale bar length (in nanometres)
3. Then:

» Either choose a length from the options available,
 Orchoose Custom , and in the pop-up window that appears, enter your preferred
length in the Value field and press Enter .

4. The scale bar length and label will now be adjusted.
To change the colour of the scale bar:

Select the View menu.

Select Scale bar colour option.

Choose from one of the colour options available.
The scale bar colour will now be adjusted.

PONPE

NB

The scale bar will not appear if there is not enough space.
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3.9.4. Viewing z-sections and timepoints

For images with multiple z-sections and/or timepoints, the Image Viewer can allow manual or
automated viewing of each section. Z-sections and timepoints can be viewed separately or
together.

3.9.4.1.Automated viewing of z-sections and timepoints
3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
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3.9.4.1. Automated viewing of z-sections and timepoints

In Section 2.4.1.1, we outlined how the z-section or timepoint being viewed can be manually
configured, using the sliders provided by the Image Viewer.

You can also view each of the image's composite z-sections or timepoints as a movie. Each

z-section or timepoint is displayed in sequence for a short time period to form the movie.

‘' 7 O Movie Player: 041206_3HT3_stain/... |

-[? |ii Play Forward (=

[ A
@ Across £ ol e Tirui

Start | 0 End 63

-

Start Emd

Figure 3.9.4.1-1 : Movie Player

To play z-sections or timepoints as a movie:

1.

o bk~ wb

In the Image Viewer window:

»  Either select the Play Movie button: .
¢  Oropen the Controls menu and select the Movie option.

The Movie Player window appears (Figure 3.9.4.1-1).
Select the Play button [.{:;. to play the movie.

Select the Stop button i to stop the movie.

When a movie is playing, the Play button becomes a Pause button H ﬂ
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3.9.4.2. Selecting z-section and timepoints

A third option for viewing different z-sections and timepoints exists when an image is shown
in Standard View and Annotation View. Holding down the mouse button and dragging the
mouse vertically up or down the image moves through z-sections; dragging horizontally
moves through timepoints. Dragging diagonally will simultaneously change z-sections and
timepoints.
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3.9.4.3. Additional Movie Player options for z-section and timepoint viewing

The Movie Player allows you to make additional adjustments to the movie being played.

To configure how the movie is played, the Play menu gives you several choices:

to Forward .
choose to stop the movie.
until you choose to stop the movie.

Backward , until you choose to stop.

Forward shows each z-section or timepoint in turn, once only.
Backward shows each z-section or timepoint in turn, once only, but in the opposite order

Loop shows each z-section or timepoint in turn Forward , but continuously until you
Loop Backward shows each z-section or timepoint in turn Backward , but continuously

Back and Forth shows each z-section or timepoint in turn, Forward and then

Table 3.9.4.3-1 shows the difference in the Play options for an example image with 5

Zz-sections numbered 1, 2, 3, 4, 5.

[Play option Frame order

[Forward 1,2,3,4,5

[Backward 5,4,32,1

[Loop 1,2,3,4,5,1,2,3,4,5/1,2
[Loop Backward 5,4,3,2,1,54,3,2,1...
[Back and forth 1,2,34,54,3,2,1,2...

Table 3.9.4.3-1 : Movie Player Play options

To specify which sections or timepoints should be included in the movie:

1.

Make sure the appropriate option is selected ( Across Z for z-sections only; Across T

for timepoints only, and Across Z and T to play a movie showing all z-sections for each

timepoint).

shown in the movie sequence:

To specify which individual z-section or timepoint is respectively the first and last to be

Either move the left-hand slider button to select the first z-section (or timepoint) and

the right-hand slider button to select the last z-section (or timepoint);

Or use the Start and End fields to type the number of the first z-section (or

timepoint) and last z-section (or timepoint).
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3.9.5. Image Rendering options

Options are also available to adjust rendering properties. Here, you adjust how the raw pixels'
intensity values are mapped to the image displayed on your monitor.

These are available by:

* Either selecting the Rendering Options toolbar button: @
*  Oropening the Controls menu and selecting the Renderer option.

This brings up the Display Settings window (shown in Figure 3.9.5-1).

-Yals Display Settings: 041206_3HT3_stain/5gol_3HT3... ]
| Controls
b4 | Mapping ./ Device Settings
=5
Tempafary Imag
=5 i
—- fi-dy—
_ ! Imrmediate Update
Min 0 Max 2484
Start 124 End 1854
(" Show Advanced Options
Save || Undo All )

Figure 3.9.5-1 : Display Settings

Adjusting the rendering parameters will result in an immediate visual change to the image
shown in the Image Viewer, except when adjusting the values of the horizontal slider. By
default, the image shown in the Image Viewer will be updated when the knobs of the
horizontal slider are released. For an immediate update, check the Immediate Update check
box.
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The horizontal slider allows you to specify start and end values for the interval of the raw data
you wish to map. This is specified separately for each channel. Alternatively you can
manually enter values in the Start and End fields.

Currently you can only select values between the displayed Min and Max values (0 and 2484 in Figure 3.9.5-1)

The vertical slider allows you to specify a range of the colour space i.e. a sub-interval of [0,
255]. This allows you to increase or decrease the overall brightness of the image.
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_rE\ ™ B Display Settings: 041206_3HT3_stain/5gol_3HT3..
| Controls

Map

Gamma

it Depth

I Mapping | ¢ Device Settings

Tempefary Imag

% -

| Immediate Update
Min 0 bax 2484
Start 124 End 1EO4

Hide Advanced Options

linear T:l

__ Moise reduction

I Sawve 1 Undo All

Figure 3.9.5-2 : Display Settings window showing advanced options

Advanced image rendering options are available by selecting the Show Advanced Options
button (Figure 3.9.5-2), This expands the Display Settings window to include options to:

Select the mapping curve (from a choice of linear, polynomial, exponential or

logarithmic) for a channel.

For polynomial or exponential curves, you can modify the shape of the curve for a

channel, by adjusting the gamma value.
Adjust bit depth.
Turn on or off noise reduction.
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Bit depths and values for the vertical slider are the same across all channels; the other parameters are specified
for each channel.

The Device Settings tab is not functional in the current version of OMERO.insight, but will in future versions
enable features such as reverse intensity and plane slicing.

Use the Save button to save rendering settings back to the database for future use.

Use the Undo All button to reset to the default rendering settings. Note that the default
rendering settings are not the ones previously saved but the internal defaults of the rendering
facility.
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3.10. The Hierarchy Viewer: viewing multiple images

For viewing a selection of images, the selection initially appears as a set of thumbnails in a
new window - the Hierarchy Viewer. What you see in the Hierarchy Viewer depends on what
you selected. Table 3.10-1 summarises how thumbnails are displayed in the Hierarchy
Viewer by default using the Hierarchical Layout option.

Selection

Hierarchy Viewer shows...

One or more images individually selected

All images in a flat view layout (see Figure
2.4.1-3)

One dataset or category

All images in one container

[Multiple datasets or categories

Multiple thumbnail containers, one for each
datasetor category

One project or category group

Multiple thumbnail containers, one for each
dataset in the project or category group

[Multiple projects or category groups

Multiple projects or category groups Multiple
thumbnail containers; one for each dataset in
each project/category group (see Figure
Figure 3.10-1)

Table 3.10-1 : Image selection method in Hierarchy Viewer display

The Hierarchy Viewer offers an alternative layout - Flat Layout option. This is a flat grid
display of all displayed thumbnails, with no containers.

To select your preferred layout option, open the View menu, select Layout and choose

between Flat and Hierarchical .
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Figure 3.10-1 : Hierarchy Viewer showing multiple containers

3.10.1.Viewing an image from the Hierarchy Viewer
3.10.2.Using the Hierarchy Viewer

3.10.2.1.Adjusting thumbnail display

3.10.2.2.Display Tree View of images

3.10.2.3.Sorting images

3.10.2.4.Managing images in the Hierarchy Viewer
3.10.2.5.Additional image information: the Working Area
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3.10.1. Viewing an image from the Hierarchy Viewer

Once you see thumbnails in the Hierarchy Viewer, you can view an individual image in more
detail in the Image Viewer through the following options:

1. Double-click on the image's thumbnail.

2. Select the image thumbnail and then select View from the Edit menu.
3. Right-click on the image thumbnail to display the Edit menu as for option 2.

The Image Viewer will then display the image as shown in Figure 2.4-1
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3.10.2. Using the Hierarchy Viewer

The Hierarchy Viewer has many additional features to allow access to information about the
current image selection.

3.10.2.1.Adjusting thumbnail display

3.10.2.2.Display Tree View of images

3.10.2.3.Sorting images

3.10.2.4.Managing images in the Hierarchy Viewer
3.10.2.5.Additional image information: the Working Area
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3.10.2.1. Adjusting thumbnail display

You can adjust the way the sets of thumbnails are displayed in the Hierarchy Viewer in a
number of ways:

Moving a container: Select the container and drag it with the mouse to wherever you wish
within the Hierarchy Viewer window.

Resizing a container: Click a corner of the container and drag the mouse to resize the
container.

NB

You cannot resize an image by dragging it, nor drag an image from one container to another.

Magnifying an individual thumbnail: To enlarge a single thumbnail:

1. Select the Magnify button (.

Move the mouse pointer over the thumbnail to be magnified. An enlarged version
appears.

3. If you have a mouse wheel, you can increase or decrease the magnification factor by
scrolling the wheel.

Continuous movement of the mouse pointer will magnify in turn each image the pointer
passes over.
To keep a specific thumbnail on screen:

1. Select the pin-up icon @ .
2. The thumbnail will now remain on screen regardless of the position of the mouse pointer.

If you have a mouse wheel, you can increase or decrease the magnification factor of the
pinned thumbnail by scrolling the wheel.
To remove a pinned-up thumbnail:

1. Select the Close button [l at the top of the thumbnail window.
2. The pinned up thumbnail is removed from display.
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NB

Closing the Hierarchy Viewer window also removes all pinned-up thumbnails.

Change the size of all thumbnails in a container: You can enlarge or reduce the size of
each thumbnail in a selected container (this includes all thumbnails in sub-containers).

To increase the size of all thumbnails:

1. Select the container.
2. Selectthe Zoom In All Images... button

To decrease the size of all thumbnails:

1. Select the container.
2. Select the Zoom Out All Images... button

-~

To reset the size of all thumbnails:

1. Select the container.
2. Select the Reset Thumbnail Size... button i .

3. Thumbnails will return to the default size.

View one thumbnail at a time in a container: Click on the Switch to Single-view mode
button. The display changes to show only one thumbnail in the selected container.

To change the thumbnail currently in view:

1. Click the Switch to Single-view mode button again.

2. Choose the Select option from the menu appears.

3. Then select the filename of the image you wish to view from the submenu that appears.
4. The displayed thumbnail changes.

To return to viewing multiple thumbnails:

1. Click the Switch to Single-view mode button again.
2. Choose the Multi-view mode option from the menu that appears.
3. You will now see all thumbnails in the container.

Collapse a container: Click on the Collapse button at the top of the container you wish to
collapse. This will temporarily remove all thumbnails from view and reduce the size of the
container. Click on the same icon again (it is now an Expand button) to bring the thumbnails
back.
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3.10.2.2. Display Tree View of images

Selecting the Display Tree View option opens a pane where you can view the files

currently shown in the Hierarchy Viewer as a tree structure - much like the left-hand pane of
the Data Manager.

When the Tree View is visible, select the Display Tree View button again to remove this
pane.
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3.10.2.3. Sorting images

Like the Data Manager, images in the Hierarchy Viewer can be sorted within a set by date or
name (see Section 3.8.1).

la? - Alphabetical sort. Select this option to sort image file names in alphabetical order.

iy - Date sort. Select this option to sort image file names in order of the date they were

taken on the microscope - and if this information is not available, in order of the date of import
into OMERO.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-88



OMERO clients User Guide

3.10.2.4. Managing images in the Hierarchy Viewer

In the Hierarchy Viewer, you can perform management actions on a single image or multiple
images:

» Categorise or decategorise an image or selection of images.

* View and edit annotations for an image or selection of images.
*  View property information of an individual image.

* Remove an image from its current dataset.

To perform any of these tasks, you can:

*  Select one or more images in a container, and then open the Edit menu to select the
operation of your choice.
*  Or, right-click on a single image to see the Edit menu as above.

Icons are used to indicate the presence of category and annotations for any image appearing
as a thumbnail in the Hierarchy Viewer; this iconic information is preserved for pinned up
thumbnails.

Clicking on an icon will bring up the corresponding tab in the Working area (see Section
3.10.2.5)
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3.10.2.5. Additional image information: the Working Area

The Working Area is an area at the bottom of the Hierarchy Viewer window where detailed

information about the currently selected image is available. Any image with a thumbnail
shown in the Hierarchy Viewer can be selected by single-clicking or double-clicking the
image.

To show the Working Area (Figure 3.10.2.5-1):

1. Select the Working Area toolbar button £ to show the Working Area; when the

Working Area is visible, select this button again to hide it;
2. Use your mouse to drag the Working Area to the desired size.
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Figure 3.10.2.5-1 : Hierarchy Viewer showing Working Area
The Working Area (illustrated in Figure 3.10.2.5-1) provides similar information to the

right-hand panel of the Data Manager. There are five tabs, each providing access to a
specific Working Area feature, and each described below.

1. Annotation: Selecting this tab views all current annotations for the selected image. You
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can add additional annotations or delete an annotation you have previously entered. For
more details see Section 3.6. This tab is selected if you click on the Annotation icon for
a thumbnail.

2. Categorisation: This enables you to see the categories the currently selected image
belongs to. You can then declassify the image's categorisation in a similar way to the
Data Manager (see Section 3.7). This tab is selected if you click on the Categorisation
icon for a thumbnail.

NB

To categorise an image or collection of images you need to use the Edit menu.

3. Find: This feature enables you to search within the selection of images shown in the
Hierarchy Viewer. The find works in a similar way to the Data Manager Find feature
(discussed in Section 2.8.2). Results are displayed in the Results panel to the right of
the Find form.

4. Editor: This enables you to view and edit Properties and Permissions information (see
Section 2.5 for more detalils).

5. Info: Shows additional information about the image, including:

Number of pixels along X and Y axes;
Number of z-sections;

Number of timepoints;

Size of a pixel in microns;

Emission wavelengths (if available).

T 0T

The Working Area can be set to automatically show information for any thumbnail when the
mouse pointer hovers over that thumbnail. To enable this functionality, select the ¢ button.

To stop this behaviour, select the button again.
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3.11. Managing windows in OMERO.insight

As you work with images in OMERO.insight, you may end up with several open windows.
The Windows menu, available at all times, shows all windows you have currently open in
OMERO.insight, and allows you to jump between windows.
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3.12. Closing OMERO.insight

To end a session using OMERO.insight, open the File menu in the Data Manager and select
Quit the Application ; or, close the Data Manager window.

Whenever you attempt to start a new action without saving edits or additions, you will be prompted to save or
cancel the changes you made.
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4. Feedback reporting

4.1.Help Information
4.2.Feedback Facility
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4.1. Help Information

Help information is not currently available through the Data Manager Help menu; but you can
send feedback by opening the Help menu and select Send Comment .

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-95



OMERO clients User Guide

4.2. Feedback Facility

This Beta version of OMERO.importer and OMERO.insight has been rigorously tested to
ensure it works as expected. Errors however may occur and a window will appear (Figure
4.2-1) inviting you to submit feedback about the error.

Providing this information is not required, but will help the development team identify and
overcome the cause of the error. Submitting your email address is optional, and if you do,
this information will only be used to contact you for more details about what you were doing
when the error occurred.

Comment

I Comments Errar Message |

An error message has been generated by the application.

Ta help ud improve our software, please fill out the following form. Your persanal
details are purely cptional, and will anly be used for development purpases.

Mease note that your application may need to be restarted to work properly.
Ernuail: ' ' o ' {Optional)
What you were doing when you crashed?

(" Cancel [ Send

Figure 4.2-1 : Error feedback form
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5. Background information

This User Guide concentrates on providing a practical guide to managing, viewing and
manipulating image in OMERO, but the following information in this section gives a brief
outline of the principles and concepts used by OMERO.

5.1.What is OMERQO?

5.2.The OMERO Environment: client and server
5.3.5-Dimensional images

5.4.The OMERO Data Model and Hierarchies
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5.1. What is OMERO?

OMERO is a set of software tools that supports image data management, visualisation and
annotation. OMERO tools include:

e an OMERO Server;
* and a series of client applications:

. OMERO.webadmin;
. OMERO.importer;
« OMERO.insight.
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5.2. The OMERO Environment: client and server

OMERO's design follows a standard client-server architecture. A single installation of an
OMERO server will usually be used for an entire laboratory or imaging facility. Image data
and metadata are typically stored on a central computer running the OMERO server, and
then accessed via a standard Ethernet network using OMERO client applications that run on
a user's workstation or laptop computer.

The OMERO Server manages all image metadata (date, size, channel names, etc.) but also
contains an image rendering facility that generates fully rendered images, ready for display in
an OMERO client application.

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-99



OMERO clients User Guide

5.3. 5-Dimensional images

OMERO allows handling of up to 5-dimensional images. As well as the conventional x and y
dimensions, you may store, view and manipulate z-sections, channels, and timepoints. The
relationship of these multiple dimensions is illustrated in Figure 5.3-1
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Figure 5.3-1 : Multiple dimensional images
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5.4. The OMERO Data Model and Hierarchies

All information in OMERO revolves around a data structure called the object hierarchy. An
understanding of this is core to efficient and effective use of OMERO. This hierarchy defines
three kinds of objects:

1. Projects
2. Datasets
3. Images

and an organisational structure for grouping these objects together. This structure is shown in
Figure 4.4-1

Project

Datasels

e @ﬁ@ —1

Figure 5.4-1 : OMERO Object hierarchy

At the top of the object hierarchy is the project. Projects represent a large, long-term
investigation, usually by either a single OMERO user or a small collection of users in the
same research group.

Each project contains a number of datasets. Projects and datasets form a many-to-many
relationship; a project can contain more than one dataset, and each dataset can belong to
more than one project. Most analysis routines are performed at the dataset level. This
provides both a convenient batch processing capability, and the ability to calculate aggregate
information about the contents of a dataset.

Each dataset contains a number of images. Like projects, images form a many-to-many
relationship with datasets. Images in OMERO are inherently multi-dimensional - they consist
of pixels across the usual three spatial dimensions, and can include multiple colour channels
and time series.
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